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[사전 준비]
ChatGPT: https://chatgpt.com/ > 가능하다면 유료 가입
Poe AI: https://poe.com/ > Gmail ID로 무료 가입
Range Program: 다운로드 https://t1.daumcdn.net/cfile/cafe/2611F0395329370A18?download 
AntConc: 사전 설치https://www.laurenceanthony.net/software/antconc/releases/AntConc431/AntConc.exe 
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Vrew: 설치 및 무료 가입 https://vrew-files.voyagerx.com/Vrew-Installer-2.9.1.exe
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DeepL: 가입 불필요 https://www.deepl.com/ko/translator (번역기) https://www.deepl.com/ko/write (교정기)
editGPT: Gmail 계정이 있는 경우 ‘Chrome에 추가’ 버튼만 클릭 https://chromewebstore.google.com/detail/editgpt/mognjodfeldknhobgbnkoomipkmlnnhk 
Orange3: 사전 설치 https://download.biolab.si/download/files/Orange3-3.38.1-Miniforge-x86_64.exe 
KH coder: 사전 설치(용량이 상당히 요구됨) https://drive.google.com/file/d/1I10Nq14pFHm1k_RrkY05RPPrXPM3w0ah/view?usp=sharing

추가자료: 가입없이 다운로드 가능 https://cafe.daum.net/sdhera/G3Jv/145 




[1차시] 

1. Making a Conversational Chatbot using ‘Custom instructions of ChatGPT’
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	-Click your ID (Name)
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	-Click ‘Custom instructions’
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	-In the first box, describe the mission you want your chatbot to fulfill, including the context of the conversation and the roles of the chatbot and user.

Example 1) A user has applied to join a soccer club. You are the club president and are now interviewing the user for membership. Answer the following three questions. Ask the first question and when the user answers, ask the second question. Ask the second question and when the user answers, ask the third question.

What grade are you in?
What is your name?
Are you good at soccer?

If the user answers at least two of the three questions correctly, approve them to sign up, otherwise reject them.
The user says Hello and Welcome to AA Soccer FC and starts the first question.

Example 2) You are a chatbot for learning English and you play the role of a ticketing agent for Kor Airline. You can suggest differently priced tickets for different dates, and you can also consult on seat assignments. You can also create a scenario to explain Kor Airlines' rules for baggage weight.

	[image: ]
	- Provide detailed requirements for how ChatGPT should respond, such as style, length of responses, and level of expression.

	[image: ]
	- You can open a new chat and practice the contextualized conversations you set, and if you want to use ChatGPT for other purposes, uncheck 'Enable for new chats' to turn it off and click 'save' to save the settings.
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	- Voice chat is available via Voice Chat


-On mobile, you can show real-time video via a live camera and talk to a chatbot at the same time.
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2. LLM-based Task-oriented Chatbot
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	-Sign up or access https://poe.com/
-Click Create Bot + in the top left corner 
-Choose the right type of chatbot for your purpose
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	-Enter the name of your chatbot in the first field (e.g., AirlineTicketingBot): no spaces If the name of your chatbot is already used by another user, re-enter it as a different name.

	[image: ]
	- Fill in the prompts, including what the chatbot does and how it responds:
Prompt: You are a chatbot for learning English and you play the role of a ticketing agent for Kor Airline. You can suggest differently priced tickets for different dates, and you can also consult on seat assignments. You can also create a scenario to explain Kor Airlines' rules for baggage weight. However, please do not make your answer too long (e.g., within 2 sentences) and use an English level of K-10 (17 years old) or below.
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	-If you have additional information for the chatbot to learn, upload it as a PDF file; for chatbots that learn foreign languages, the information entered in the prompt is sufficient.
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	-Enter your chatbot's opening words in Greeting message (e.g., Hello, welcome to Kor Airline! What can I help you?).
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	-advanced: Select 'Suggest replies' to provide users with suggested expressions as an additional setting, and also raise the number in 'Custom temperature' for creative speech and lower for conservative, typical speech.
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	-Introduce the purpose and characteristics of the developed chatbot in 'About me' and decide whether to open access to the general public, then click 'save' at the bottom.
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	1. Options
2. Choose ‘Edit bot’ to modify the prompt
3. Click the icon to share the chatbot link 
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	-Learners can submit their practiced dialog as an assignment by clicking Share, selecting the dialog lines, and clicking copy the share link.
When the learner submits the dialog, the teacher can see if the learner has selectively submitted only successful dialogs.

	[image: ]
	







[2차시]

1-1. 어휘목록 제작(Range Program)
어휘족 목록을 개발하기 위해서는 먼저 Nation과 Webb(2011)의 BNC-COCA 25,000에 포함된 1-25까지의 basewrds를 basewrd1 하나로 모두 복사 또는 잘라내어 합친다. 이것으로 소위 Familizer25라 한다. 만약 하이픈으로 연결된 합성어까지 포함하고 싶다면 1-28까지의 basewrds를 통합한다. 이 프로그램을 Familizer28이라 한다. 통합된 파일은 일종의 어휘족 은행 또는 데이터베이스로 활용된다. 
(1) 그 다음은 어휘족의 대표형을 추출할 소스로 사용할 코퍼스(텍스트)를 선택해야 한다. 사용목적에 따라서 코퍼스는 교과서가 될 수도 있고 특정 분야의 언어자료가 될 수 있다. 예를 들어 10개의 코퍼스를 소스로 활용한다고 가정할 때 보다 일반적인 단어를 추출하기 위해서는 구어자료(spoken corpus)의 비율을 높여야 한다. 반면 문어자료(written corpus)의 비율이 높이면 보다 어려운 단어들이 포함될 수 있다. 
(2) 단어 선별의 기준은 위에서 언급한 바와 같이 빈도수(frequency), 사용범위(range), 사용분포(dispersion)를 고려해 볼 수 있다. 소스선택과 일관성을 유지하려면 보다 일반적으로 사용되는 단어를 선별해야 하고 그러기 위해서는 사용범위를 가장 우선순위에 두어야 한다. 사용분포는 단어형태(type)에만 적용할 수 있는 관계로 Familizer만을 이용하여 어휘족 목록을 제작하고자 한다면 기준에서 제외 될 수밖에 없다 또한 빈도수와 사용분포는 상관관계가 상당히 높아 제외한다 하여도 결과 값에는 큰 영향을 미치지 않는다. 빈도수와 사용범위의 수치를 구하기 위해 다음과 같은 절차를 따른다.
(2-1) [그림 15] 왼쪽 상단에 보이는 File을 클릭하고 Open을 클릭하여 분석하고자 하는 코퍼스들을 불러온다.
(2-2) 먼저 분석한 결과 값을 Save를 클릭하여 원하는 이름의 파일로 저장한다. 일반적으로 여타 프로그램에서는 결과 값은 분석 후에 저장하도록 되어 있지만 본 프로그램에서는 저장 후 분석을 진행한다는 점이 색다르다. 
(2-3) 사용하는 어휘족 목록이 basewrd1으로 통합되어 있는 관계로 하단의 Number of Baseword Files에는 1로 입력하고 Basewrd1 On만 선택한다. Basewrd2 On과 Basewrd3 On에는 클릭하여 선택을 해제한다. 분석 어휘의 정렬 순서를 위해 Sort by Freq(빈도순) 또는 Sort by Range(사용범위순)를 선택한다.
[image: EMB00005b5c178d]
[그림 15] 프로그램 실행과정

(3) [그림 16]와 같이 결과분석 파일을 열고 LIST OF FAMILY GROUPS를 찾는다.

[image: EMB00005b5c178e]
[그림 16] 결과분석

위의 자료를 복사해서 엑셀(EXCEL) 프로그램에 붙여 넣는다.
(3-1) [그림 17]과 같이 엑셀에 자료를 붙여 넣은 후 BASE ONE FAMILIES, RANGE, FAFREQ의 값만 남기고 나머지는 삭제한다.

[image: EMB00005b5c178f]
[그림 17] 엑셀 데이터 입력

(3-2) 엑셀의 자료에서 정렬부분을 지정하고 데이터 정렬 기능에서 첫째기준과 둘째 기준에
사용범위(Range)든 빈도수(Frequency)든 사용목적이나 사용자의 선택에 따라 입력하고 내림차순으로 [그림 18]와 같이 재정렬을 시행한다.
[image: EMB00005b5c1790]
[그림 18] 엑셀 데이터 정렬
등급별 어휘목록을 개발하기 위해 개별 어휘의 순위를 결정하는 방식으로는 위에서 살펴본 우선순위 선정 기준의 순차적용 방식이 지금까지는 가장 일반적이었지만 그 방식에는 몇 가지 기준을 추가하여 다음의 <표 9>와 같이 다양한 적용이 가능하다(신동광, 2018).

<표 9> 어휘 등급 구분을 위한 순위 확정 방식 예시
	순위 
확정 
방식
	기준 적용 절차
	비고

	유형 1
	친숙도>초등권장 어휘 추천>사용범위>빈도수 순차 적용 순위
	

	유형 2
	t점수 변환 후 가중치를 곱한 값들의 합을 기준으로 한 순위
	친숙도×0.4+초등권장 어휘 추천×0.3+사용범위×0.2+빈도수×0.1

	유형 3
	t점수 변환 후 가중치를 곱하지 않은 값들의 합을 기준으로 한 순위
	　
　

	유형 4
	원점수에 가중치를 곱한 값들의 합을 기준으로 한 순위
	친숙도×0.4+초등권장 어휘 추천×0.3+빈도수×0.2+사용범위×0.1

	유형 5
	원점수에 가중치를 곱하지 않은 값들의 합을 기준으로 한 순위
	친숙도+초등권장 어휘 추천+사용범위+빈도수

	유형 6
	빈도수>사용범위>초등권장 어휘 추천>친숙도 순차 적용 순위
	

	유형 7
	t점수 변환 후 가중치를 곱한 값들의 합을 기준으로 한 순위
	빈도수×0.4+사용범위×0.3+초등권장 어휘 추천×0.2+친숙도×0.1

	유형 8
	원점수에 가중치를 곱한 값들의 합을 기준으로 한 순위
	빈도수×0.4+사용범위×0.3+초등권장 어휘 추천×0.2+친숙도×0.1



위의 <표 9>에 제시된 8개의 선정 방식은 어휘 선정 기준을 순차적으로 적용하는 방식과 합산하는 방식, 원점수를 적용하는 방식과 t점수로 치환하여 적용하는 방식, 각 어휘 선정 기준을 동일한 비율로 적용하는 방식과 0.1배에서 0.4배까지 가중치를 두고 적용하는 방식으로 구분된다. 만약 기존의 방식과 마찬가지로 유형 1과 같이 우선순위 선정 기준의 순차적용 방식을 적용하게 되면 첫 번째 기준이 순위 확정에 거의 절대적인 영향을 주기 때문에 다양한 기준을 균형있게 반영하기 어렵다(1순위 값으로 순위를 나열한 후 동일한 값을 가지는 항목에 2순위의 값을 적용하여 재정렬하고 2순위의 값도 같을 경우 3순위의 값을 적용하는 방식). 이를 보완하기 위한 방식이 각 기준의 값을 통합하여 하나의 수치로 순위를 확정하는 방식이 제안된 것이다. 하지만 각 기준의 수치 단위가 다를 경우 수치의 단위가 큰 기준이 절대적인 영향을 주기 때문에 수치의 단위를 같게 조정할 필요가 있다(위에서 제시된 t값을 의미). 하지만 통합값을 적용할 경우에도 어휘목록의 개발의 목적을 고려하여 특정 기준에 가중을 적용할 필요도 제기될 수 있고 이를 반영한 방식이 유형 2라고 볼 수 있다. 

(3-3) [그림 19]와 같이 선별 기준에 따라 표제어(대표형) 정렬이 끝나면 예외항목의 여부를 결정해야 한다. 고유명사나 감탄사는 예외항목으로 두는 것이 일반적이며 이를 위해서는 표제어에서는 삭제를 해야 한다. 알파벳, 숫자, 나라명, 단위명칭, 외래어 등은 예외항목으로 제외시킬 것인지, 어휘족 목록에 포함시킬 것인지를 선택하고 예외항목으로 두고자 한다면 표제어 목록에서는 고유명사나 감탄사와 마찬가지로 삭제해야 한다. 그러한 선별과정이 끝나면 어휘족 목록의 단위를 결정하여 그 단위만큼 표제어를 복사하여야 한다. 즉 수준별 단어목록을 제작한다고 할 때 한 수준이 올라갈 때 마다 추가되는 어휘족의 양을 100단어, 250단어, 500단어, 1,000단어 단위 등으로 결정해야 한다. 1,000단어 단위로 결정을 하게 되면 수준별로 각 1,000단어씩 증대되게 된다. [그림 19]는 20단어씩 증대되는 어휘족 목록을 제작하는 예시로 첫 20단어의 표제어를 복사하여 어휘족을 목록을 만들고 그 다음으로 그 다음 20단어를 복사하여 어휘족 목록을 만들면 된다.
[image: EMB00005b5c1791]
[그림 19] 어휘족(family) 목록 제작을 위한 표제어(headword) 선택
(4) 어휘족 목록을 만들기 위해서는 복사한 표제어를 메모장(텍스트 파일)에 붙여 저장하고 Familizer의 open을 클릭하여 저장한 파일을 불러오고 basewrd1 on만 선택, Number of Baseword Files를 1로 수정, Update basewords, Zero basewords를 클릭한다. 그 다음 Save한 후 Process Files를 클릭하면 Range 값이 저장된다. 실제로는 분석 값은 불필요한 것이지만 절차 상 필요한 과정이다.

(5) Familizer를 통해 분석을 마치고나면 [그림 20]과 같이 상단의 File를 클릭하여 Move/Copy Basewords를 선택하고 greater than 0을 클릭, Copy words를 클릭, basewrd4를 본인이 원하는 이름으로 입력, 단 basewrd1을 제외한 다른 이름 또는 그대로 basewrd4로 써도 상관없다.

[image: EMB00005b5c1792][그림 20] 선택 어휘족(family) 복사

(6) Move/Copy Basewords 기능을 통해 [그림 20]에서 OK를 클릭하면 지정한 이름, 즉 basewrd4의 이름으로 다음과 같은 어휘족 목록(family list)이 생성된다. 단, Nation의 14,000단어 내에 포함된 어휘족만 생성된다. basewrd4를 basewrd1로 바꿔 따로 저장하고 [그림 19]에서 분석한 그 다음의 단어를 선택하여 똑같은 절차로 어휘족을 생성하여 basewrd2로 저장하고 계속 원하는 만큼 반복하면 사용자만의 수준별 어휘족 목록이 작성된다. RANGE 프로그램 폴더에 기존의 basewrd를 삭제하고 제작한 어휘족 목록을 붙여 넣으면 새로운 RANGE 프로그램의 제작이 끝난다.
	[image: EMB00005b5c1793]


[그림 21] 어휘족(family) 목록 생성

(7) 고유명사와 같은 예외항목이 있을 경우 basewrd를 하나 더 만들고 그 안에 [그림 22]과 같이 추가 항목을 입력해 주면 된다.
	kimchi 0
gimchi 0
america 0
american 0
americans 0
minsu 0
minhee 0


[그림 22] 어휘족(family) 목록 생성






1-2. 어휘 통제하기(AntWordProfiler)
[image: EMB00005b5c176d]
❶ 좌측 하단의 기존 3개 어휘목록을 드래그(drag)하여 하이라이트 한 후 ‘Clear’ 버튼을 클릭하여 삭제하고 ‘Choose’를 클릭하여 위에서 제작한 어휘목록 또는 교육과정 어휘 Basewrd1~Basewrd4 파일(초등수준은 basewrd4까지, 중등수준은 basedwrd6까지)을 대신 업로드하여 탑재한다. 좌측 상단에 어휘통제를 할 지문을 텍스트(txt) 파일 형태로 ‘Choose’를 클릭하여 불러온다. 한국어 목록을 탑재하면 한국어 분석도 가능하다.
[image: EMB00005b5c176e]

[image: EMB00005b5c176f]
❷-❸ 상단 옵션의 ‘Setting’에 들어가서 ‘Thesaurus Settings’를 선택한다. 팝업 창이 뜨면 좌측 상단의 ‘Use thesaurus’를 선택하고 우측 하단의 ‘Apply’를 클릭하여 유의어 사전의 기능을 활성화한다. 좌측 상단 박스 화면 위의 ‘View’를 클릭하여 ❸과 같이 새 창을 연다.
[image: EMB00005b5c1770]
❹ (교육과정 어휘목록을 탑재하 경우) 하단의 ‘Level List Words’를 클릭하면 4개의 어휘목록에 해당되는 어휘 분포의 비율과 해당 어휘가 각기 다른 색으로 표시된다. Level 1은 초등권장어휘 800개(word family 기준), Level 2는 외래어 200개, Level 3는 예외어휘(단위, 숫자 등) 129개(추가 가능), Level 4는 고유명사-12289개(추가 가능)을 의미하며 Level 0은 초등교육과정의 수준을 벗어난 어휘의 비율이다.

[image: EMB00005b5c1771]
❺ 하단의 ‘Non-Level List Words’를 클릭하면 Level 0에 포함된 단어들(수정 대상 어휘)만 빨간색으로 표시된다.

[image: EMB00005b5c1772]
❻ 우측 중간의 ‘Total Hits’는 분석 어휘목록을 벗어나 Level 0(수정 대상 어휘)에 포함된 단어수가 136개라는 것을 의미하는 것이고 ‘Next’ 버튼을 클릭하면 최초 수정 대상 단어부터 그 다음 수정 대상 단어로 커서가 이동한다. 초등 영어과 교육과정 어휘수준으로 지문을 통제하고자 한다면 화면에서 바로 쉬운 단어로 교체하여 입력하면 된다. 화면상에서 바로 수정이 가능하며 수정된 자료는 하단의 ‘Save’버튼으로 따로 저장할 수 있다. 위의 화면에서 하이라이트 된 ‘hole’이라는 단어를 선택하면 ‘Hit Position’ 항목에 3이라 제시되는데 이는 총 136개의 수정 대상 중 세 번째 단어라는 것을 의미하며 ‘Edit’ 버튼을 클릭하면 교체 가능한 유의어들이 제시된다. 유의어 목록에 원하는 대체어가 있을 경우 해당 문장 내에서 교체 가능(Replace)하며 지문 전체의 동일 단어에 대해 일괄 대체 적용(Replace All)도 가능하다. 만약 적절한 대체어가 없을 경우 유의어 목록 창을 닫고 외부의 유의어 사전을 참고하며 화면에서 직접 원하는 표현을 입력하여 수정하거나 또는 삭제 등의 편집이 가능하다. 수정 작업을 하면서 ‘Non-Level List Words’ 버튼을 수시로 클릭하면 수정 후 Level 0의 업데이트된 비율을 확인할 수 있다. 이 비율이 5% 이내가 될 때까지 계속 수정해 나간다. 끝으로 지문의 수정이 완료되면 하단의 ‘Save’버튼을 클릭하여 수정본을 저장한다. 










1-3. Automated Test Item Generator
	[image: EMB00005b5c1797]
* If you want to control the level of vocabulary, you'll need to upload the vocabulary list you created above and add prompts to your instructions that explain the coverage of vocabulary for each grade or level.

	-Click ‘Configure’
-Fill out the template

-Instructions:
-Please create test items based on the Achievement Standard code, including the question + passage + options + answer choice + answer explanation + expected selection rate per option + expected rate of correct answer.
-When creating items, create three items with a different difficulty level (Low, Medium, High) at the same time.
-Use the model item types as a guide, but create an item with a new passage based on different topics. 
-Write a 100-150 word passage for the middle school (중학교) level and a 150-200 word passage for the high school (고등학교) level. 
-If the item includes a picture, please refer to the item and create and present it through DALL-E 3. When creating the item, refer to the attached file in the section of Knowledge. 
-If you used materials from an internet search, please provide a link to the source. 
-When generating a passage, make it similar to the length and the vocabulary level of the model item's passage.

		School Year
	1st Grade in High School 

	Achievement Standard Information
	Curriculum
	〼 2015 National Curriculum
	□ 2022 National Curriculum

	
	Achievement Standard
	You can read articles on general topics you're familiar with and dig into the details.

	
	Achievement Standard Code 
	[10영03-01]

	Model
Test Item
	Learning Elements
	To identify details (drawings, photos, diagrams, objects, topics)

	
	Keywords
	Seminar, Modern Technology, San Francisco, Keynote Speakers

	
	Topic
	Invitation to the annual seminar on modern technological advances

	
	Item No.
	E_10_3.1.1.3.1_01

	
	Item Type
	MCQ (Multiple-choice Question)

	
	Question
	What was not mentioned in the following article about seminars?

	
	Passage
	Dear Kelly,
I am delighted to inform you that our annual seminar on modern technology progress is just around the corner. The seminar is scheduled to take place in San Francisco, California on the 15th of September. Our keynote speakers for this event are Dr. Emily Gray from Stanford University and Mr. John Lee, from a famous tech company. We expect many audiences, from students to experienced experts in the tech industry. Notably, members from top Silicon Valley firms will also be present. Please note that a detailed schedule and topics to be discussed will be sent to you a week before the event. I hope to see you there.

Warm regards,
James Whitmore

	
	Visual aids
	

	
	Choices
	1. Topic
1. Place
1. Speaker
1. Food Menu
1. Companies attending

	
	correct answer
	④

	
	expected rate of correct answer
	0%~10%
	10%~20%
	20%~30%
	30%~40%
	40%~50%

	
	
	
	
	
	
	

	
	
	50%~60%
	60%~70%
	70%~80%
	80%~90%
	90%~100%

	
	
	
	√
	
	
	



	- Prepare a PDF document to upload to Knowledge that includes detailed additional information such as ‘Test Item Card’


	Test Item Type: Multiple Choice
Passage: Dear Kelly, I am delighted to inform you that our annual seminar on modern technology progress is just around the corner. The seminar is scheduled to take place in San Francisco, California, on the 15th of September. Our keynote speakers for this event are Dr. Emily Gray from Stanford University and Mr. John Lee from a famous tech company. We expect many audiences from students to experienced experts in the tech industry. Notably, members from top Silicon Valley firms will also be present. Please note that a detailed schedule and topics to be discussed will be sent to you a week before the event. I hope to see you there. Warm regards, James Whitmore
Question: What is NOT mentioned in the above passage about the seminar?
Options:
1. 1. The topic of the seminar.
1. 2. The location of the seminar.
1. 3. The speakers at the seminar.
1. 4. The food menu at the seminar.
1. 5. The companies expected to attend.
Answer: 4. The food menu at the seminar.
Explanation: The passage mentions the topic, location, speakers, and expected attendees of the seminar. However, it does not mention anything about the food menu.
Expected Selection Rate per Option:
1. Option 1: 10% - 20%
1. Option 2: 0% - 10%
1. Option 3: 0% - 10%
1. Option 4: 60% - 70%
1. Option 5: 10% - 20%
Expected Rate of Correct Answer: 60% - 70%
	-Choose Web Browsing and DALL-E Image Generation
-Choose options to publish and click ‘Confirm’
-By only entering a curriculum code, the corresponding test items will be generated in high, medium, and low difficulty, respectively.
-If you want to modify the generated test items, you can enter additional requirements. For example, if the passages are too short, you can also type "Make the passages a bit longer".



Standard Achievements in the 2015 National Curriculum of English, South Korea
중학교 1-3(9)
[9영03-01] 문장을 의미 단위로 끊어 읽으면서 의미를 파악할 수 있다. 
[9영03-02] 일상생활이나 친숙한 일반적 대상이나 주제에 관한 글을 읽고 세부 정보를 파악할 수 있다. 
[9영03-03] 일상생활이나 친숙한 일반적 주제의 그림, 사진, 또는 도표에 관한 글을 읽고 세부정보를 파악할 수 있다. 
[9영03-04] 일상생활이나 친숙한 일반적 주제의 글을 읽고 줄거리, 주제, 요지를 파악할 수 있다. 
[9영03-05] 일상생활이나 친숙한 일반적 주제의 글을 읽고 필자의 심정이나 태도를 추론할 수 있다. 
[9영03-06] 일상생활이나 친숙한 일반적 주제의 글을 읽고 필자의 의도나 목적을 추론할 수 있다. 
[9영03-07] 일상생활이나 친숙한 일반적 주제의 글을 읽고 일이나 사건의 순서, 전후관계를 추론할 수 있다. 
[9영03-08] 일상생활이나 친숙한 일반적 주제의 글을 읽고 일이나 사건의 원인과 결과를 추론할 수 있다. 
[9영03-09] 일상생활이나 친숙한 일반적 주제의 글을 읽고 문맥을 통해 낱말, 어구 또는 문장의 함축적 의미를 추론할 수 있다.

고등고통영어(6)
[10영03-01] 친숙한 일반적 주제에 관한 글을 읽고 세부 정보를 파악할 수 있다. 
[10영03-02] 친숙한 일반적 주제에 관한 글을 읽고 주제 및 요지를 파악할 수 있다. 
[10영03-03] 친숙한 일반적 주제에 관한 글을 읽고 내용의 논리적 관계를 파악할 수 있다. 
[10영03-04] 친숙한 일반적 주제에 관한 글을 읽고 필자의 의도나 글의 목적을 파악할 수 있다. 
[10영03-05] 친숙한 일반적 주제에 관한 글을 읽고 필자의 심정이나 태도를 추론할 수 있다. 
[10영03-06] 친숙한 일반적 주제에 관한 글을 읽고 함축적 의미를 추론할 수 있다.
고등영어1(6)
[12영I03-01] 일반적 주제에 관한 글을 읽고 세부 정보를 파악할 수 있다. 
[12영I03-02] 일반적 주제에 관한 글을 읽고 주제 및 요지를 파악할 수 있다. 
[12영I03-03] 일반적 주제에 관한 글을 읽고 내용의 논리적 관계를 파악할 수 있다. 
[12영I03-04] 일반적 주제에 관한 글을 읽고 필자의 의도나 글의 목적을 파악할 수 있다. 
[12영I03-05] 일반적 주제에 관한 글을 읽고 필자의 심정이나 태도를 추론할 수 있다. 
[12영I03-06] 일반적 주제에 관한 글을 읽고 함축적 의미를 추론할 수 있다.
2. Automated Essay Scoring System
	[image: EMB00005b5c17ab]
	-Click ‘Explore GPTs’
-Click ‘Create’

	[image: EMB00005b5c17ac]
	-Click ‘Configure’
-Fill out the template

-Instructions:
· Grade each of the four scoring domains Task Completion, Content, Organization, and Language Use based on the Writing Scoring Criteria.
· Refer to the sample questions and sample scores for each scoring domain as a guide. Along with your scores, provide specific feedback that you can provide to learners. 
· The essays you have to score are written by non-native English speakers, so you do not need to deduct too many points from 'Language Use' for minor grammatical errors if the content of the essay is not difficult to understand.
· As you increase the minimum word count for a question, you can also increase the level of grading criteria.
· Finally, present an error-corrected version of the answer that preserves the wording of the user's input as much as possible.

	[image: EMB00005b5c17ad]
	- Prepare a PDF document to upload to Knowledge that includes detailed additional information such as "Scoring Rubric," "Sample Test Item," and "Sample Responses for Each Score per Scoring Domain

	[image: EMB00005b5c17ae]
	[image: EMB00005b5c17af]
	-If the tool you are developing requires web searching, select Web Browsing; if it requires image generation, select DALL-E Image Generation; if it requires programming code generation or interpretation, select the Code Interpreter line.

-Choose options to publish and click ‘Confirm’

		A sample question and essay
	[image: EMB00005b5c17b0]

	Grading scores and reasons for grading
	[image: EMB00005b5c17b1]

	Feedback for the learner
	[image: EMB00005b5c17b2]

	Revised essay
	[image: EMB00005b5c17b3]



	-After you enter a question to test and its answer, you get grading results, feedback, and a revised essay.



Automated Essay Scoring System: An essay sample
Arguments for and against the idea that students should be allowed to work part-time jobs. Using this as a guide, choose a position, write an introduction, discuss three reasons, and write a conclusion. (80-120 words)

I agree with the student having part-time job becaues of following two reasons. First, as students work in the real workplace, they can develop their sense of responsibility. For instance, if a student was working, and had trouble with a customer, then he need to solve the problems himself, because there is no one to back him up at the real work place. Second, students can experience a lot of different things in other word, as they experience various thing, they may find the area they are talented in, so student should learn something from the practice not just theory they learn from the school. Therefore, i agree with the student having part-time jobs. 






3. Automated English Grammar Feedback Provider
1) Knowledge
		Student’s First Draft 
	You know what? There are CCTV on our schools hall.  Everybody hate them. But I like it. Why? Because it can detect violenxe when it occurs. If there isn't CCTV, teacher Jangtaehyean, who is our school's guardian, can't catch the bullys. Second, CCTV can provide evidence. If Yongwoon killed people, we don't no about that with CCTV. Last, it can offer psycological anxiety to criminals. So, Criminal will decrease. And our society will be a Utopia. Accordingly, CCTV must be setup everybody's school.

	Sentence-by-sentence numbered draft
	① You know what? ② There are CCTV on our schools hall. ③ Everybody hate them. ④ But I like it. ⑤ Why? ⑥ Because it can detect violenxe when it occurs. ⑦ If there isn't CCTV, teacher Jangtaehyean, who is our school's guardian, can't catch the bullys. ⑧ Second, CCTV can provide evidence. ⑨ If Yongwoon killed people, we don't no about that with CCTV. ⑩ Last, it can offer psycological anxiety to criminals. ⑪ So, Criminal will decrease. ⑫ And our society will be a Utopia. ⑬ Accordingly, CCTV must be setup everybody's school.



<피드백 제공을 위한 대화 예시>
챗봇: ① "You know what?의 표현을 바꿔볼까요?
학습자: What do you think?
챗봇: Guess라는 동사를 써보면 어떨까?
학습자: 아! Guess what?
챗봇: 좋아요. 다음 ② There are CCTV on our schools hall.에서 문법 오류를 수정해 볼래?
학습자: 뭐가 잘못된 지 모르겠어!
챗봇: 수 일치를 생각해봐.
학습자: There are CCTVs on our schools hall.
챗봇: 오류가 하나 더 있어 찾아서 수정해 볼래?
학습자: There are CCTVs on our school hall.
챗봇: Good job! 그럼 ③ Everybody hate them. ④ But I like it. 여기에선 뭐가 잘못됐을까?
학습자: 두 문장의 수가 일치하지 않나?
챗봇: 맞아. 그럼 어딜 고쳐야 하지?
학습자: 잘 모르겠어.
챗봇: CCTV를 가리키는 대명사를 them과 it으로 혼용하고 있잖아! 어떤 결로 할래?
학습자: them?
챗봇: 그 다음 문장에도 it으로 통일하고 있으니 it을 좋을 것 같아. 그럼 ⑥ Because it can detect violenxe when it occurs.에서 오류를 찾아 수정해 볼까?
학습자: 철자가 틀렸네. violence?
챗봇: 맞아. 오류는 아니지만 occurs도 happens가 더 자연스러울 것 같아!
학습자: 그렇구나! 그 다음은?
챗봇: ⑦ If there isn't CCTV, teacher Jangtaehyean, who is our school's guardian, can't catch the bullys. 여기엔 어떤 오류가 있을까?
학습자: 잘 모르겠어.
챗봇: 복수형이 잘못된 게 있어.
학습자: 뭐지?
챗봇: bullys →bullies
학습자: 맞다!
챗봇: ⑨ If Yongwoon killed people, we don't no about that with CCTV. 이것도 수정해 볼래?
학습자: 지금 보다 어이없는 실수네! We don’t know that
챗봇: 좋았어. 그런데 we won’t know it이 더 좋을 것 같아. ⑩ Last, it can offer psycological anxiety to criminals.에서 어떤 걸 고칠 수 있을까?
학습자: 이건 정말 모르겠다.
챗봇: 문법적 오류라기 보다는 좀 더 자연스런 표현으로 고쳐봐.
학습자: 모르겠어.
챗봇: Lastly, it can provide psychological fear to criminals.가 좀 다 자연스러워 보여.
학습자: 그러네. 너 정말 잘 고친다.
챗봇: 고마워. 

챗봇: ⑪ So, Criminal will decrease.에는 어떤 오류가 있지?
학습자: 대소문자인가?
챗봇: 그것도 있지만 criminals 또는 crime이라고 해야 할 것 같아.
학습자: 맞네. 
챗봇: ⑫ And our society will be a Utopia.도 수정해봐.
학습자: 음…
챗봇: 도와줄까?
학습자: 어.
챗봇: Utopia처럼 대문자로 쓰려면 a를 삭제하거나 a를 쓸거면 utopia처럼 소문자로 써야 할 것 같아. 마지막 문장 ⑬ Accordingly, CCTV must be setup everybody's school.을 수정해 볼래?
학습자: setup보다는 installed 잘 어울리겠다. 
챗봇: 맞아. 그리고 everybody보다는 everyone이 더 자연스러워.
학습자: 그러네. 이제 끝났네. 고마워. 많은 도움이 됐어.
챗봇: 별말씀을... 다음은 위에서 수정한 내용을 반영한 최종 수정본이야.
Guess what? There are CCTVs in our school hall. Everybody hates it. But I like it. Why do you like it? Because it can detect violence when it happens. If there is no CCTV, teacher Jangtaehyean, who is the guardian of our school, can't catch the bullies. Second, CCTV can provide evidence. If Yongwoon killed people, we won't know about it with CCTV. Lastly, it can provide psychological fear to criminals. So the number of criminals will decrease. And our society will be a utopia. Accordingly, CCTV must be installed in everyone's school.
학습자: 고마워



2) Instructions
	-Check grammatical errors and awkward phrasing as the user types, and provide step-by-step feedback based on the sample feedback file in the Knowledge section. 
-Number each sentence in the user's text and include the number and sentence together in your feedback.
-Present erroneous sentences one at a time and give the user a chance to find and correct the errors.
-If the user can't find the error, or if the user's correction is incorrect, tell the user explicitly what the error is in grammatical terms, and if the user's correction is still incorrect, present the corrected sentence.  
-When asking the user to identify and correct errors, and when explaining corrective feedback, please chat in Korean language except when referring to target sentences in the input text.
-Once again, if you give the user a sentence and ask him/her to correct the error and he/she doesn't know, don't mention the correct wording, just tell him/her that there is a mistake and to correct it. For example, if there is an error in the number of matches, don't mention the correct wording, but hint that there is an error in the number of matches and correct it. If the user doesn't correct the error correctly after a second chance, explain it in detail and point out the correct wording.
-Give the user at least 2 chances to correct the error, with a few more hints if they fail. Even if you've provided corrective feedback after two unsuccessful attempts to correct the error, if additional errors remain or the user has questions, provide additional feedback and ask for feedback on whether the user wants to move on to the next error sentence after making sure you've explained enough.
-After providing feedback on the first incorrect sentence, present the next incorrect sentence and follow the same procedure for providing feedback.
-Overall, the error feedback phase consists of providing an opportunity for error recognition and correction, providing a brief description of what the error is in grammatical terms if error recognition or correction fails, providing an opportunity for correction (without mentioning the corrected expression), and then explicitly providing the corrected expression if correction still fails. If the user says he/she doesn't know, don't give him/her the answer right away, but give him/her another chance to correct grammatical errors as described above.
-When the feedback and correction activity for the last erroneous sentence is complete, present the final corrected version of the text.

	-사용자가 입력할 때 문법 오류와 어색한 표현을 확인하고 Knowledge base 섹션의 샘플 피드백 파일에 따라 단계별 피드백을 제공하세요. 
-사용자의 텍스트에 있는 각 문장에 번호를 매기고 피드백에 번호와 문장을 함께 포함하세요.
-오류가 있는 문장을 한 번에 하나씩 제시하고 사용자가 오류를 찾아 수정할 수 있는 주세요.
-사용자에게 문장을 제시하고 오류를 수정하도록 요청했는데 사용자가 모르는 경우 올바른 표현을 언급하지 말고 오류가 있다고만 말하고 수정하라고 말하세요. 예를 들어, 일치 횟수에 오류가 있는 경우 정확한 표현을 언급하지 말고 일치 횟수에 오류가 있음을 암시하고 수정하도록 안내하세요. 사용자가 두 번째 기회에도 오류를 올바르게 수정하지 않으면 자세히 설명하고 올바른 표현을 지적하세요.
-사용자에게 오류를 수정할 수 있는 기회를 최소 2회 이상 주고, 실패할 경우 몇 가지 힌트를 더 제공하세요.
-첫 번째 틀린 문장에 대한 피드백을 제공한 후, 다음 틀린 문장을 제시하고 동일한 절차에 따라 피드백을 제공하세요.
-전체적으로 오류 피드백 단계는 오류 인식 및 수정 기회 제공, 오류 인식 또는 수정에 실패한 경우 문법적으로 오류가 무엇인지 간략하게 설명하기, 수정할 기회를 제공(수정된 표현에 대한 언급 없이), 그래도 수정이 실패한 경우 수정된 표현을 명시적으로 제공합니다. 사용자가 모른다고 답하면 바로 답을 주지 말고 위에서 설명한 대로 문법 오류를 수정할 수 있는 기회를 다시 제공하세요.
-입력된 텍스트의 문장을 참조할 때를 제외하고는 대화창을 한국어로 유지해주세요.
-마지막 오류 문장에 대한 피드백 및 수정 활동이 완료되면 최종 수정된 텍스트를 제시하세요.
-문장 단위로 물어보세요.














[3차시]

1. Automated Picture Story Book Generator
	Create a short story meeting the following conditions:

-Setting: [castle]
-Character: [Minhee, Susan, Zombie]
-Conflict: [love triangle]
-Genre: [detective story]
-Length limit: [300] words
-Target expression: [some of the following expressions: yellow, red, blue, green, shirt, skirt, pants, dress, short curly hair, short straight hair, long curly hair, long straight hair, big eyes, small eyes, wear, have]
-Target audience: [K4] 
	-By providing a common set of target expressions for learning goals and letting students fill in other information themselves, students can read their own unique texts and still reach common learning goals.

- You can also ask them to extend the text or replace certain phrases with simpler ones.

	[image: EMB000032fc2355]
	

	[image: EMB000032fc2356]
	ChatGPT Plus is equipped with DALL-E 3 to generate images, which can be used to create picture books.

For free image generation tools, you can use Bing Image Generator (https://www.bing.com/images/create ) or Adobe Firefly (https://firefly.adobe.com/?ff_channel=adobe_com&ff_campaign=ffly_homepage&ff_source=firefly_seo), both of which are equipped with DALL-E 3.

In the case of the paid DALL-E 3, you can request a unique image ID number called seed No. to create a series of images with a specific character, but this feature is limited in the free version. 

There are already publicly available image generation tools that can keep characters through My GPTs (e.g., https://chat.openai.com/g/g-XxQgZLxX9-consistent-image-generator)

	[image: EMB000032fc2357]
	



2. Automated Song/Chant Generator
	Custom mode
	Non-custom mode
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	[image: ]

	Suno AI는 두 가지 모드를 제공한다.  custom mode에서는 그림과 같이 사용자가 입력한 가사에서 사용자가 선택한 음악 장르의 멜로디를 생성하여 노래를 생성하고, non-custom mode에서는 사용자가 특정 가사를 참조하는 프롬프트를 작성하거나 주제만 제공하고 애플리케이션이 가사와 멜로디를 모두 생성하도록 요청할 수 있다. 예를 들어, 사용자는 다음과 같이 다양한 스타일의 사용자 지정 노래를 생성하도록 프롬프트를 입력할 수 있다.

Prompt 1
Create a ballad song using the following: 
Twinkle, twinkle little star
How I wonder what you are
Up above the world so high
Like a diamond in the sky
Twinkle, twinkle little star
How I wonder what you are

Prompt 2
Make me a song of slow tempo K-pop mixed with Jersey club style with the easy beat of 4/4. Use the title “Twinkle, twinkle, little star.”


	Custom mode
	Non-custom mode
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	https://suno.com/song/83b46f61-a3b2-4122-b685-ace532b53e7d 

	https://suno.com/song/64c6e7b5-3b1f-477a-9f73-2ca50e2191fa 



3. Automated Video Generator(Sora, Visla, Veo 2)
	[image: ]
	-Sora를 가입하면 ChatGPT에도 아이콘 생성됨


	[image: ]
	-화면 비율
-화질
-동영상 시간(최대 20초)
-비디오 생성 개수(최대 4개)
-묘사글 입력 또는 스토리보드 사용 후 장면별 입력

	Scene 1: In a magical castle, Minhee, with her short curly hair and big eyes, was a smart detective. Scene 2: Susan, in a red dress and long straight hair, had a kind heart. 	
Scene 3: Zombie, wearing old pants, added mystery to their world.
Scene 4: Minhee discovered an old magic, linking Zombie's future to the castle's treasure. Zombie and Susan were childhood friends, cursed by a witch. 	
Scene 5: With Minhee's help, as they shared memories, the curse broke, showing the hidden treasure―a box of precious things.	
Scene 6:  Minhee, the detective, solved the mystery, bringing together unlikely friends. As the sun set, they knew love and friendship were the most important things.
	-스토리 보드 사용 시
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	-스토리 보드 확인 후 수정 및 비디오 생성
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	-Blend 기능으로 여러 동영상을 붙여서 사용 가능 
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	-Vrew 설치 후 ‘새로 만들기’ 선택택
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	-‘텍스트 비디오 만들기’ 선택

	[image: ]
	-화면 비울 선택
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	-비디오 스타일 선택
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	-주제만 입력하고 AI로 대본 작성 가능
-장면별 직접 대본 입력
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	-언어별 목소리 선택(무료/유료)

[image: ]

-한국어의 제시된 문장 따라읽기로 자신의 목소리 더빙 가능
-이미지 시리즈 또는 동영상 방식 결정
-배경음악 설정

	[image: ]
	-대본 수정 가능, 대본 수정 시 영상 자동 수정
-끼워 넣기, 삭제 가능
-기존 영상 편집 가능



4. Automated Text Level Converter
	[image: ]
	-학습에 사용할 사이트의 자료 화면에서 Brisk Teaching의 B 버튼 클릭 
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	-Create: 교수학습 자료 개발
-Give Feedback: 업로드한 학습자의 산출물에 자동 피드백 제공
-Change Level: 온라인 자료의 학년별 수준 또는 번역 후 변환

	[image: ]
	-Create의 세부 기능
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	-Text 수준 변환

	[image: ]
	-구글 문서에 변환된 텍스트 제시
-번역, 텍스트 길이, 텍스트 상세화 정도 조정 가능


	[image: ]
	-Quiz 기능을 통해 이해도 평가 제작 가능
-텍스트 창에 다양한 형태의 문항 유형 제작 지시 가능
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	-지문 아래 개발된 문항 제시 또는 구글 설문지 형태로 평가 가능
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	-문항 유형 추가 및 채점 가능





5. Automated Translating and Proofreading
	
	

	[image: ]
	-수정할 표현 선택 가능

	[image: ]
	-문체 조정 가능



	[image: EMB00004bac3d94]
	-You can install editGPT as a Chrome extension at https://chromewebstore.google.com/detail/editgpt/mognjodfeldknhobgbnkoomipkmlnnhk to use it in ChatGPT, but the features provided are limited.

	[image: EMB00004bac3d95]
	-수정된 부분을 수용/거부, 수정 후 되돌리기 가능
-ChatGPT 화면 상단의 editGPT 아이콘을 켜고 끌수 있으며 화면에 나타나지 않을 경우 대화창에 proofread를 입력하면 다시 나타남


[4차시]

1. Orange3
무료 프로그램 중 하나인 Orange3는 텍스트 마이닝(text mining)을 비롯한 다양한 데이터 분석에 활용할 수 있다. 특히 코딩 작업 없이도 기능별 아이콘의 배열만으로도 데이터 분석이 가능하다. 또한 추가적인 분석 기능이 필요한 경우 Options를 클릭하고 Add-ons 선택하여 원하는 기능을 프로그램에 추가할 수 있다. 텍스트 마이닝 분석 기능을 추가하려면 Add-ons에서 Text를 선택하여 다운로드 받으면 된다. 다양한 분석 기능 중 본 절에서는 감성분석(sentiment analysis)의 분석 기법을 소개하고자 한다. 감성분석은 다양한 영역에서 활용되고 있다. 소비자의 소비 패턴이나 상품평과 같은 댓글에 나타난 감성분석에 초점을 둔 경우에는 오피니언 마이닝이라는 용어로 더 알려져 있다. 교육영역에서는 설문지의 개방형 질문에 나타난 긍정/중립/부정 등의 감성을 분석하는데 유용하게 활용될 수 있다. 다음의 표는 챗봇 활용 활동 후 학습자들의 소감을 번역기를 통해 영문으로 변환한 자료이다. 한국어 감성분석의 경우 보통 감성어휘사전을 R 프로그램에 탑재하여 분석에 활용하는데 아직은 영문 분석에 비해 정확도가 떨어지고 별도의 코딩 작업이 필요하기 때문에 번역기를 통해 영문으로 변환할 경우 다소 오차가 있기는 하겠지만 분석의 정확도 측면에서는 보다 나은 분석 기법일 수 있다. 
	[image: EMB00005b5c1781]



위에서 설명한 바와 같이 Orange3에 Text라는 기능을 다운로드 받으면 아래 그림과 같이 왼쪽 기능 아이콘 모음에 ‘Text Mining’이란 섹션이 활성화된다. 먼저 아이콘 모음에서 차례로 ‘Corpus’, ‘Preprocess Text’, ‘Setiment Analysis’, ‘Data Table’을 드래그하여 우측 화면에 놓고 선으로 아이콘들을 이어준다. 

	[image: EMB00005b5c1782]
	[image: EMB00005b5c1783]



추가적으로 워드클라우드(word cloud)를 분석하고 싶으면 ‘Word Cloud’ 아이콘을 추가하고 ‘Preprocess Text’와 연결해 주면 된다. 아이콘 배열이 끝나면 ‘Corpus’를 클릭하여 <표-6>과 같은 분석할 엑셀 파일을 업로드 한다. ‘Preprocess Text’은 분석의 정확도를 높이기 위해 ‘stop word’라는 분석에서 제외할 어휘를 입력하는 기능이 포함되어 있다. 기본 설정에서는 기능어가 ‘stop word’로 설정되어 분석에서 제외된다. 다음으로 ‘Sentiment Analysis’에서는 분석 알고리듬을 선택하면 되는데 본 절의 분석에서는 감성어휘사전을 기반으로 한 Vadar 방식을 선택하였다. 그 결과는 우측 하단의 표와 같으며 긍정/중립/부정의 각 수치는 0-1까지 제시되며 통합값(compound)에서는 1에 가까울수록 ‘긍정’, 0에 가까울수록 ‘중립’, -1에 가까울수록 ‘부정’을 의미한다. 끝으로 우측 상단은 어휘 사용의 빈도수를 바탕으로 한 워드클라우드 분석결과의 예시이다. 이 밖의 다른 기능들은 유튜브(YouTube)에서 Orange3를 검색하면 자세한 분석과정에 대한 강의를 들을 수 있다(https://cafe.daum.net/sdhera/MGXe/229).

2. KH Coder
1) 데이터 업로드 및 전처리
-Project > New > Browse(엑셀 데이터 불러오기) > English(분석언어 설정) > Pre-Processing > Run Pre-Preprocessing
	[image: EMB0000432c1696]
	[image: EMB0000432c1697]
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	-Excel 파일은 Excel 통합문서의 형식으로 저장(구버전 저장 시 인식 못하는 경우가 있음)



2) 품사가 구분된 레마(lemma) 목록 만들기 
-Tools > Words > Frequency List > Term Freq(TF)/Document Freq(DF) 중 택 1 > Excel
	[image: EMB0000432c1698]
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3) 연어 관계 분석하기
-Tools > Words > KWIC Concordance > 검색어 입력하기(예, sky) > Search > Stats > The Score로 연어 관계 분석 공식 변경 가능
	[image: EMB0000432c169a]
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4) 이야기 흐름별 키워드 추출하기
-Project > Settings > Standford POS Tagger: Stop words: Config > Function word 입력 > Run Pre-Processing(내용어 분석만 원하면)
	[image: EMB0000432c169c]
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-Tools > Words > Correspondence Analysis > Words × Variable(s)에서 분석기준을 part/chapter 중 택 1(chapter가 너무 많으면 분석 결과의 해석이 어렵기때문에 큰 단위인 part를 권장), Bubble plot을 마우스 오른쪽 버튼으로 선택하면 주요 키워드 빈도수를 버블로 제시 > 특정 단어를 클릭하면 Concordance 예시 확인 가능 

	[image: EMB0000432c169e]



-각 Part를 나타내는 붉은색 박스를 기준으로 박스의 근처에 분포하는 어휘들이 각 part의 주요 키워드이며 세로축과 가로축 0 지점에 가까울수록 전체 이야기에 공통적인 키워드임

5) 특정 주제어와 연계된 각 part의 키워드 찾기
-Tools > Words > Word Association > Browse(Coding Rule File 불러오기, 예시 code_3)

	[image: EMB0000432c169f]
	-*는 산출 결과의 제목을 의미하며 그 아래는 분석 대상(예, Marilla)

-각 part가 포함하는 chapter의 범위 기술
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	-분석 키워드인 Marilla를 클릭하고 이 키워드와 연계어를 분석하기 위해 분석하고자 하는 part를 선택, part를 선택할 때는 Ctrl 키를 누르고 마우스로 원하는 part 선택

-Unit에서 분석단위를 Sentence로 할 것인지 Paragraph로 할 것인지 택 1

-분석을 위해 Run 클릭
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	-part 3(chapters 20-28)에서 Marilla와 가장 밀접한 단어는 “Allan”이란 캐릭터

-그래픽으로 확인하기 위해서는 Network 버튼 클릭

-Jaccard는 어휘 간의 거리를 측정하는 알고리듬이지만 절대빈도 등 여러 공식 선택 가능, 공식에 따라 수치와 그래픽이 달라짐

	[image: EMB0000432c16a2]
Config에서 마우스 오른쪽 버튼으로 Show Coef.를 선택하면 계수와 함께 제시
	[image: EMB0000432c16a3]
HTML 버전 



6) 여러 주제어들 간의 part/chapter별 평균빈도(χ2) 비교하기
-Tools > Coding > Crosstab > Browse(Coding Rule File 불러오기, 예시 code_1)

	[image: EMB0000432c16a4]
	-5명의 주요 등장 인물 평균빈도 비교

	[image: EMB0000432c16a5]
	-Coding Unit에서 빈도분석 단위를 Sentence 또는 Paragraph 택 1

-Crosstab에서 part에서 빈도를 분석할지 chapter에서의 빈도를 분석할지 택 1

	[image: EMB0000432c16a6]

각 등장 인물의 part별 빈도비율이 제시되어 어떤 part에서 비중이 큰지를 확인
	[image: EMB0000432c16a7]
bubble을 선택하면 그래픽으로 각 part의 중요 인물 확인 가능



7) 특정 주제어와 특정 연계어 간의 관계성 분석하기(예, 등장 인물들과 감정동사 간의 관계 분석)
-Tools > Coding > Co-Occurrence Network > Browse(Coding Rule File 불러오기, 예시 code_2)
	[image: EMB0000432c16a8]
	-code_2에서 분석 어휘 앞에 #있는 경우는 메모처럼 사용하기 위해 입력하기 때문에 메모가 필요없으면 사용하지 않음

	[image: EMB0000432c16a9]
	-Coding Unit에서 빈도분석 단위를 Sentence 또는 Paragraph 택 1
-수치가 잘 나오지 않으면 Top 10을 조정 > Top 40 등 

	[image: EMB0000432c16aa]
	-Marilla와 Anne 사이에 say 동사가 가장 많이 연결되어 두 사람 사이의 대화가 많다는 것을 알 수 있고 Anne과 Diana, 그리고 Anne과 Gilbert의 관계성은 보이지만 Diana와 Gilbert의 직접적인 관계성은 없다는 것을 확인 가능
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What would you like ChatGPT to know about you to provide better responses?

Auser has applied to join a soccer club. You are the club president
and are now interviewing the user for membership. Answer the
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[Paul hated school. He did not do his homework. He did not like his teachers.
[Paul's father did not know what to do with him. His teachers did not know
either. One afterncon, all his teachers at Pittsburgh high school met together
‘with him to discuss his case. Paul was late. When he entered the room his
teachers sat waiting for him

He was tall for his age and very thin._ His clothes were too small for him, but
they were clean. He had a bright red flower in the button hole of his black
jacket. One of the teachers asked Paul why he had come to the mesting. Paul
said politely that he wanted to do better in school. This was a lie. Paul often
lied

His teachers began to speak. They had many complaints. One said Paul
talked to the other students instead of paying attention to the lessons. Another
'said Paul always sat in class with his hands covering his eyes. A third teacher
'said Paul looked out the window instead of looking at her. His teachers
attacked him without mercy.

Paus eyesbrows moved up and down as his teachers spoke. His smile never
It his face, but his fingers shook as he touched the flower on his coat. At last
the meeting was over. Paul's smile got even wider. He bowed gracefully and left
the room.

His teachers were angry and confused. The ar teacher spoke for all of them
‘when he said there was something about Paul that he didn't understand. '1
|dont think he really means t0 be bad.” he said. "There's just something wrong
\with that boy."? Then the art teacher ramemberad one warm aftemoon when
Paul had fallen asleep in his class. Paul's face was white with thin blue veins
lunder the skin. The boy's face looked tired and lined, like an old mans. His.
eyebrows moved up and down. even in his sleep

\After he It the meeting, Paul ran down the hill from the school whistling. He
was late for his job at the concert hall. Paul was an usher there. He showsd

Level List Words. Non-Level List Words

Token Coverage %
I o
Lovel Coverage (%)
(P |
ez Wl
Lovel 3
Level +
Level 0

Total Hits °
Hit Position °
Local Freq °

prev | [ Next |

Save Options.
@ None
© Add Level Index Tags





image29.png
lunder the skin_ The boy's face looked tired and ined. like an old mans. His
eyebrows moved up and down. even in his sleep.

\After he It the meeting, 2. ran down the il from the school whistling. He
was late for his job at the concert hall. =,/ was an usher there. He showed
lpeople to their seats. He carried messages for them. He brought them their
lprograms with a polite bow. Everyone thought he was a charming boy and the
lbest usher at the hall

When . reached the concert hall that evening, he went immediately to the
(dressing room. About six boys were already there. ©=.. began changing his
(clothes with excited hands. He loved his green uniform with the gold pockets
/and design.

. rushed into the concert hall as soon as he had changed clathes. He ran
lup and down the hall, helping peaple_ He became more and more excited. His
fface became pink and his eyes seemed larger and very bright. He looked
simost handsome. At last sveryone was seated. The orchestra began to play
/and 5. sat down with a sign of relief.

The music seemed to free something in . spirit. Then & woman came out
iand began to sing. She had a rich, strong soprano voice. "2 el truly happy
for the first time that day.

At the end of the concert 71 went back to the dressing room. After he had
ichanged his clothes again he went outsids the concert hall. He decided to wait
ffor the singer to come out. Whill he waited he looked across the street to the
large hote! called “The Schenley."? All the important people stayed at The.
'Schenley when they visited - i</, . had never been inside it, but he
lused to stand near the hotels wide glass doors. He liked to watch the people
jenter and leave. He believed i he could only enter this kind of a hotsl, he would
be able to leave school, his teachers, and his ordinary, gray fife behind him.
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[Paul hated school. He did not do his homework._ He did not ke his teachers
Paul's father did not know what to do with him His teachers cid nt know
|either. One afternoon. all his teachers at Pittsburgh high school met together
with him to discuss his case. Paul was late. When he entered the room his
eachers sat waiting for him
o was tall for his age and very thin. His clothes were too small for him. but
Ithey were clean- He had a bright fed flower in the bulton hole of his black
jackel_ One of the teachers asked Paul why he had come to the meeting Paul
Isaid politely that he wanted to do better in chool. This was a lie. Paul oftan
ed
His teachers began to speak. They had many complaints. One said Paul
talked to the ciher students instead of paying aitention to the lessons. Another
|said Paul aiways sat n class with his hands overing his eyes. A third teacher
|said Paul looked out the window nstead of looking at her. His teachers
|attacked him without mercy’
Pauls eyesbrows maved up and down as his teachers spoke His smill never
lof his face. but his fingers shook as he touched the flower on his coat. At last
the masting was over. Paurs amile got sven wider. He bowed graceully and left
the room
|His teachers were angry and confused. The ar teacher spoke for all of them
\when he said there was something about Paul that he didn' understand.
dant think he really means to be bad.” he aaid. “Thers's just something wrong
with that boy."? Ther the ar teacher remembered one warm aftermoon when
[Paul had fallen asleep in his class. Paurs face was whits with thin blue veins
undor the skin The boy's face looked fired and lined. ke an old mans. His
yebrows moved p and down, zven in his sleep.
|Afler he leR the meeting, Paul tan down the hill fom the schaol whisting. He
[wes ate for his job st the concer hall. Paul was an usher there_ He showsd
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English Test ltem Generator based on the 2015 National Curriculum of English
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“When creating items, create three items with a different difficulty level (Low, Medium, High) at the same time.
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@ You

Arguments for and against the idea that students should be allowed to work part-time
jobs. Using this as a guide, choose a position, write an introduction, discuss three
reasons, and write a conclusion. (80-120 words)

| agree with the student having part-time job becaues of following two reasons. First, as
students work in the real workplace, they can develop their sense of responsibility. For
instance, if a student was working, and had trouble with a customer, then he need to
solve the problems himself, because there is no one to back him up at the real work
place. Second, students can experience a lot of different things in other word, as they
experience various thing, they may find the area they are talented in, so student should
learn something from the practice not just theory they learn from the school.
Therefore, i agree with the student having part-time jobs.
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KR-Automated Essay Scoring System
Evaluation of Your Essay

. Task Completion: Your essay scores a 4 in Task Completion. You clearly choose a
position in favor of students having part-time jobs and provide two reasons
supporting this stance. However, the prompt requested three reasons, and your essay
includes only two, which slightly limits the completion of the task.

. Content: For Content, your score is 4. You provide relevant and mostly complete
content. Your reasons are clear: developing a sense of responsibility and gaining
varied experiences. These points are pertinent and well-explained. However, an
additional reason would have enriched the content and made it more thorough.

. Organization: Your essay scores a8 in Organization. You have a clear introduction and
conclusion, and the main points are identifiable. However, the organization of ideas
within the body could be improved for better clarity and flow.

. Language Use: The score for Language Use is 3. You use appropriate vocabulary and

sentence structures for the most part. However, there are several grammar errors that

slightly hinder the clarity of your message, such as "becaues" instead of "because,”
and "he need to solve" instead of "he needs to solve.”
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Feedback for Improvement:

* Task Completion: To improve, ensure you address all parts of the prompt. The prompt.
requested three reasons, so including a third reason would have fully met the task
requirements.

* Content: Your content is relevant and mostly complete. For a higher score, provide
more depth in your discussion by expanding on your reasons or adding the third
reason as the prompt required.

* Organization: Enhance the logical flow between your points. Clear transitions and a
more structured progression of ideas would improve this aspect.

* Language Use: Pay attention to grammatical accuracy and spellings. Proofreading

your essay could help identify and correct these errors.
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Error-Corrected Version:

| agree that students should have part-time jobs for the following two reasons. First, as
students work in real workplaces, they can develop their sense of responsibility. For
instance, if a student faces a customer issue, he needs to resolve it independently, as
there s no backup in the actual workplace. Second, part-time jobs allow students to
experience various things. As they navigate different situations, they might discover
their talents, learning practical skills beyond school theory. Therefore, | support

students in having part-time jobs.
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In a magical castle, Minhee, with her short curly hair and big eyes, was a smart
detective. Susan, in a red dress and long straight hair, had a kind heart. Zombie,
wearing old pants, added mystery to their world..

Minhee discovered an old magic, linking Zombie's future to the castle's treasure.
Only true love could break it. Zombie and Susan were childhood friends, cursed by a
witch. With Minhee's help, as they shared memories, the curse broke, showing the
hidden treasure — a box of precious things..

Minhee, the detective, solved the mystery, bringing together unlikely friends. As the
sun set, they knew love and friendship were the most important things..
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WVerse]

Twinkle twinkle little star
How | wonder what you are
Up above the world so high
Like adiamond in the sky

Verse 2]
Mystery in the vast midnight
Whispers cosmic in moonlight
Guiding dreamers lost and far
Twinkle bright oh wonder's scar

Glimmer soft in silent night
Keep your secrets hidden tight
‘Shine on down from realms afar
Twinkle twinkle fittle star
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It looked like an ordinary murder.

One hundred years ago on this day - 12 January 1925 - a group of men attacked a
couple on a car ride in a upmarket suburb in Bombay (now Mumbai) in colonial India,
shooting the man dead and slashing the woman's face.

But the story that unfolded brought global spotlight on the case, while its complexity
put the country's then British rulers in a spot of bother, and eventually forced an
Indian king to abdicate.

Newspapers and magazines described the murder as "perhaps the most sensational
crime committed in British India", and it became "the talk of the city" during the
investigation and subsequent trial.
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